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Packet Tracer 3 Lab â€“ VLSM 1

Create a simulated multi-router network topology using Packet Tracer ... lab by running the tutorials found under the Help menu option in Packet Tracer. Step 1. 
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Packet Tracer 3 Lab – VLSM 1



Objective • • • •



Create a simulated multi-router network topology using Packet Tracer Design an IP addressing scheme using a Class C network address and VLSM Apply IP addresses to the routers and workstations in the simulation Test the simulated topology to verify IP connectivity



Background / Preparation You are responsible for designing a network that interconnects 3 geographically separated sites, each with its own LAN. You have a class C network address to work with and must make the best use of the address space while minimizing wasted addresses. To accomplish this you will develop an IP addressing scheme using Variable Length Subnet Masks (VLSM) to allocate IP addresses to the LANs and WAN links in the network. You will apply the addresses to the routers and workstations in the simulated network and then test to ensure that it works. Routers simulated with Packet Tracer use RIP version 2 to find routes to remote networks automatically. A router advertises all networks that its ports belong to, which is specified by the IP address and subnet mask. RIP version 2 supports VLSM. RIP keeps a routing table of remote networks. The routing table associates a network (network ID and subnet mask or network bits) to the port on that is closest to the network. A router can have one default port. It is recommended that you become familiar with the basic features of Packet Tracer prior to starting this lab by running the tutorials found under the Help menu option in Packet Tracer. Step 1. Design an IP Addressing Scheme Using VLSM Starting with the Class C network address of 192.168.1.0/24, create subnets to allocate IP addresses to the Ethernet LANs and WAN links in the network topology shown above. The design requirements for the number of addresses are listed in the table below. Use VLSM to minimize
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wasted IP addresses. Assume ip subnet-zero is enabled and that the first subnet (all zeros) and last subnet (all ones) can be used. As a general rule it is best to first allocate subnets to the networks with the largest number of required hosts starting from the lowest subnet number and working up. Ethernet networks will require more IP addresses than WAN links. Be sure to minimize the number of addresses used on the WAN links and allocate WAN subnets starting at the highest subnet. Document your VLSM subnet design using the table below. You will use these subnet address ranges to assign interface addresses to the routers and workstations in the scenario.



Address Area



Number of IP Addresses



32 Bit Address Prefix and Slash (/) Bit Mask



32 Bit Dotted Decimal Subnet Mask



Class C Network Assigned



256 total (254 useable)



192.168.1.0 / 24



255.255.255.0



Router 0 LAN Router 1 LAN Router 2 LAN Router 0-1 WAN Router 1-2 WAN



55 hosts 26 hosts 12 hosts 2 hosts 2 hosts



Step 2. Create the Basic Topology a. Open the Packet Tracer application to create the simulated topology. The topology consists of 3 routers interconnected by dedicated WAN serial links. A single workstation on each LAN represents the group of IP addresses required as indicated in the table in step 1. b. Change to Expert Mode. Click on the Options menu and de-select Simple Mode. This will put you in Expert Mode and give you more control over the configuration. The figure below shows the networking device icons available in Packet Tracer used to create topologies. The Connect lightning bolt icon is used to link the networking devices. The Remove pencil eraser icon can be used to delete any device or link.



c.
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Place the routers in the topology. From the Topology Tab, click and drag a Router icon to the workspace and click again to paste it in position. Repeat this until the three routers shown in the diagram are present. You may also double click the router icon and then click 3 times to paste multiple icons in the workspace. Click the Cancel icon in the lower right corner when finished or to abort an operation. Note that the three Packet Tracer 3 Lab – VLSM 1
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routers are initially named Router 0, Router 1 and Router 2. If required, review the tutorial to learn how to change the names of the routers. d. Place the switches in the topology. From the Topology Tab, click and drag a Switch icon to the workspace and click to paste it in position. Repeat this until the three switches shown in the diagram are present. You may also double click the switch icon and then click 3 times to paste multiple icons in the workspace. Click the Cancel icon in the lower right corner when finished. Note that the three switches are initially named Switch 0, Switch 1 and Switch 2. If required, review the tutorial to learn how to change the names of the switches. e. Place the workstations in the topology. From the Topology Tab, click and drag a PC icon to the workspace and click to paste it in position. Repeat this until the three PCs shown in the diagram are present. You may also double click the PC icon and then click 3 times to paste multiple icons in the workspace. Click the Cancel icon in the lower right corner when finished. Note that the three PCs are initially named PC 0, PC 1 and PC 2. If required, review the tutorial to learn how to change the names of the workstations. Step 3. Connect the Networking Devices Note: By default, each Packet Tracer router has 4 Ethernet and 2 Serial ports numbered as shown in the figure below. Ports 0 and 1 are RJ-45 Fast Ethernet. Ports 2 and 3 are D-Connector type Serial. Ports 4 and 5 are Fiber Fast Ethernet. In the figure below, Serial Port 2 is selected with the Port Config options displayed. This port is enabled (status=on or not shut down), bandwidth is 1.544 Mbps and DCE clocking is enabled. An IP address and subnet mask have been configured. Ports can be added or removed as desired.



a. Create the WAN Links



Click on the Connect lightning bolt icon to create the WAN Link between routers 0 and 1. When the Connect icon is selected in Expert Mode, you are prompted for the connection type. Select Serial



3-5



Packet Tracer 3 Lab – VLSM 1



Copyright  2004, Cisco Systems, Inc.



DCE and then Click on Router 0. Select Port 2: Serial on the router (This is the first serial port on Router 0). Next, click Router 1 and select Port 3: Serial on the router (This is the second serial port on Router 1, use the first serial port on Router 1 for the connection to Router 2). Repeat this process for the WAN connection between Routers 1 and 2. Select Serial DCE as the initial connection type. On Router 1 select Port 2: Serial. On Router 2 select Port 3: Serial. What is the color of the Dots under the Interface numbers on the router WAN links? ________



b. Configure the Serial Interface clocking on Routers 0 and 1



Select Router 0 and click on port 2 (the first serial link). Refer to the figure above to select the button that enables clocking. Select Router 1 and click on port 2, then click on the button that enables clocking. On Router 1, verify that clocking is disabled on port 3. Select Router 2 and click port 3 to verify that clocking is disabled. What is the color of the Dots under the Interface numbers on the router WAN link? ________



c. Configuring the LAN Links



Click on the Options menu and select Simple Mode. Click on the Connect lightning bolt icon. Create a LAN Link connection between the first router 0 and switch 0.Click on the Connect lightning bolt icon again. Create a LAN Link connection between switch 0 and PC 0. Repeat this process for the other routers, switches and PCs. The Interface status indicator dots between routers, switches and PCs should be green.



Step 4. Configure IP Addresses on the Routers and Workstations



a. Assign Router IP Addresses



Select Router 0 and click on Ethernet Port 0. Enter an IP Address and subnet mask for the LAN interface from the VLSM subnet scheme developed in step 1. Next select Serial Interface 2 and enter an IP Address and subnet mask for the WAN interface. Repeat this process on the other two routers to assign IP addresses and subnet masks as appropriate for the LAN and WAN interfaces. Use the table below to record your IP addresses for the router interfaces.



Device Router 0



Interface Ethernet port 0 Serial port 2



Router 1



Ethernet port 0 Serial port 2 Serial port 3



Router 2



Ethernet port 0 Serial port 3



IP Address



Subnet mask



b. Assign Workstation IP Addresses



Select PC 0 (Ethernet Port 0 should be the only port available), and enter an IP Address and subnet mask for the PC from the VLSM subnet scheme developed in step 1. Next enter the IP address of the Gateway. This is the IP address of the Router 0 Ethernet LAN interface. Repeat this process to assign IP addresses, subnet masks and gateways as appropriate for the other two PCs.
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Device



Interface



PC 0



Ethernet port 0



PC 1



Ethernet port 0



PC 2



Ethernet port 0



IP Address



Subnet mask



Gateway IP Address



Step 5. Test the IP Addressing VLSM Scheme



a. Click on the Simulation Tab and select the Add Packet button (Plus (+) sign and a small envelope b. c.



d. e.



next to it). A packet on the timeline will display the word “defining”. Click on source PC 0 and then click on destination PC 2. The timeline window should display a colored packet with “PC 0 >> PC 2” next to it. Simulate a ping, by selecting the blue right arrow button in the white square of the player controls (middle blue button in above figure). This will send the packet from PC 0 to PC 2 and test IP connectivity. The packet should pass through all devices in the path and reach PC 2. A green check mark will display on PC 2 if the ping is successful. To complete the testing, click on the Add Packet icon again and test connectivity from PC 1 to PC 0. Add a third packet and test from PC 1 to PC 2. Each new packet will be assigned a different color. If further testing is required, select the New button to start a new series of packets. If the pings are not successful, troubleshoot the IP addressing scheme and addresses/subnet masks assigned to ensure that they are compatible.



Step 6. Save the Topology



a. Select File Menu and click Save. Save the topology under the Name of VLSM1-XXX where XXX is your initials.



Step 7. Reflection a. What would have happened in the simulation if RIP v1 was used as the routing protocol?



b. Could the network have been subnetted and still provide an adequate number of IP addresses for each network without using VLSM? ____________________________________________________________________________ c.



How many addresses would have been wasted if the network 192.168.1.64/27 was used for the WAN link between Router 0 and Router 1?



____________________________________________________________________________
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... de voir quelles configurations sont éventuellement encore manquantes. Effectuez les corrections nécessaires et testez à nouveau la connectivité complète.
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Tous droits réservés. Ceci est un document public de Cisco. Page 1 / 3. Packet Tracer : configuration de la récapitulation de route IPv4, scénario 2. Topologie ...
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G0/1. 192.168.30.1. 255.255.255.0. NN/A. S0/0/0. 10.3.3.2. 255.255.255.252 N/A. S0/0/1. 10.2.2.2. 255.255.255.252 N/A. S1. VLAN10. DHCP assigned.
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Packet Tracer - Cours CCNA 

Identifiant de connexion au port de console et mot de passe : cisco. - Mot de passe d'activation chiffrÃ© : class. - Chiffrement des mots de passe en clair.
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Tous droits réservés. Ceci est un document public de Cisco. Page 2 / 3. Table d'adressage. Périphérique. Interface. Adresse/Préfixe IPv6. Passerelle par défaut.
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Cisco Packet Tracer Overview 

Supports lectures, group and individual labs, ... Students who troubleshoot networks using Packet Tracer develop problem solving ... The process is basically write instructions, build a correct answer network, ... Integrated Help and Tutorials ...
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Scénario. L'administrateur réseau remplace le routeur et le commutateur existants par un nouveau commutateur de couche 3. En tant que technicien réseau, ...
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Packet Tracer : configuration de RIPv2 

2014 Cisco et/ou ses filiales. Tous droits réservés. Ceci est un document public de Cisco. Page 1 / 2. Packet Tracer : configuration de RIPv2. Topologie. Objectifs.
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2014 Cisco et/ou ses filiales. Tous droits rÃ©servÃ©s. Ceci est un document public de Cisco. Page 1 / 2. Packet Tracer : configuration de SSH. Topologie. Table d' ...
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DÃ©terminez la solution pour les erreurs d'adressage et corrigez la documentation dans la table d'adressage. b. AprÃ¨s avoir rectifiÃ© le systÃ¨me d'adressage, ...
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Packet Tracer : analyse de la convergence 

Comparez le résultat des deux routeurs. Étape 2 : Vérifiez l'état de la topologie. a. Envoyez une requête ping à PC3 depuis PC2. La requête ping devrait aboutir.
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Packet Tracer : configuration des trunks - Nyu Planet 

Ceci est un document public de Cisco. Page 1 / 3. Packet Tracer : configuration des trunks. Topologie. Table d'adressage. PÃ©riphÃ©rique Interface Adresse IP.
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Packet Tracer : navigation à travers IOS 

Cliquez sur l'icône de l'application Terminal et vérifiez que les paramètres Port Configuration par défaut sont corrects. Quelle est la valeur du paramètre des bits ...
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Packet Tracer : reprÃ©sentation du rÃ©seau 

souvent cette topologie dans les cours du programme Networking Academy). ... g. Cliquez sur le bouton bascule situÃ© au-dessus de Simulation dans le coin ...
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Packet Tracer : configuration du protocole RIPng 

Ceci est un document public de Cisco. Page 1 / 2. Packet Tracer : configuration du protocole RIPng. Topologie. Table d'adressage. Périphérique Interface.
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Packet Tracer - Configuration de l'adressage IPv6 

Cliquez sur Web Browser (navigateur web). Entrez 2001:DB8:1:1::4 dans la zone de l'URL et cliquez sur Go (OK). Le site web Accounting doit apparaÃ®tre. c.
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